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Functional Description

The TVP7000EVM refers to the TVP7000 board and the THS8200 board when they are
connected together. Both boards share a common interface via a 120-pin connector. This
interface provides all data, clocks, I°C communication, and 5-V power to each board.

The THS8200 is a Texas Instruments Triple DAC providing component analog RGB or YPbPr
outputs. As such, the THS8200 supports resolutions up to SXGA for PC graphics and up to
1080p for video. This triple DAC minimizes artifacts commonly associated with backend
processing. lIts purpose is only to convert the digital data from the TVP7000 Triple ADC back
to analog. Use of a quality TV or display capable of supporting both component RGB and
YPDbPr analog inputs is recommended.

Description Overview

The TVP7000EVM is powered by a single, 5-V, universal supply. FC communication is
emulated using a PC parallel port configured for the extended capability port (ECP) or
bidirectional mode. The parallel port mode can be changed using the PC BIOS setup,
available during the reboot process.

The TVP7000 Triple ADC converts three channels of analog video input into digital component
data. This digital data and the associated clocks from the TVP7000 are sent to the THS8200.

Control of the TVP7000EVM is provided by WinVCC, a Windows-based application developed
by Texas Instruments and provided free of charge. This application uses the parallel port to
provide FC communication to the TVP7000EVM. WinVCC provides a graphics user interface
(GUI) and a register level interface to program and vary the controls available within the
TVP7000 Triple ADC and the THS8200.

TVP7000EVM User’'s Guide 3
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2 Board Level Description

The following subsections describe the various features available on the TVP7000EVM.
Figure 1 shows the block diagram for the TVP7000EVM.

DB25 (12C)
5V
DB15 LED
Reset|:| 12C ] DLED
||:Ad||dr_ Testpoints
= . ] R/Pr|
S I=4
et 150, : : [ ]
VSYNC  CLK £ £ THS8200
8 S B/Pb
TVP7000 5 )
n T =]
HSYNC £ g S
<3 T T L G/Y
1) £ £
S I T —
GIY 3 Q
- = DB15
R/Pr
B/Pb L

Figure 1. TVP7000EVM Block Diagram

2.1 Analog Inputs

The TVP7000EVM makes use of all the available inputs on the TVP7000 Triple ADC. The
following inputs are available for use:

?  Five BNC connectors (Y/G, Pb/B, Pr/R, HSYNC, and VSYNC)
?  One DB15 graphics connector (Y/G, Pb/B, Pr/R, HSYNC, and VSYNC)

Table 1 shows the pins used for the inputs described above.

Table 1. Analog Inputs and Pin Terminals

Input Type TVP7000 Pin(s)
5BNC RIN_1, GIN_1, BIN_1, VSYNC_B,
HSYNC_B
DB15 RIN_3, GIN_3, BIN_3, VSYNC_A,
HSYNC_A

4 TVP7000EVM User’'s Guide
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2.2

2.3

External Clock Input

An SMA connector (EXT CLK) is provided on the TVP7000EVM for use with an external ADC
sample clock. This input is end-terminated with a 50-? resistor for use with a lab clock
generator and is routed to pin 80 (EXT CLK) of the TVP7000.

An external sample clock can be used by placing the TVP7000 in the PLL free-run mode (I°C
register OFh[0] = 1). The free-run mode decouples the internal PLL clock from the ADCs and
establishes a direct connection from EXT CLK pin to the ADC sample clock. Removal of the
termination resistor may be required for some clock sources incapable of driving the 50-? load.
The EXT CLK input can be left unconnected for applications using the internal PLL clock.

Test Points and Jumpers

Various test points are available on the TVP7000EVM. This includes COAST, CLAMP, TEST,
SOG_OUT, SDA, SCL, power, and GND. Each test point is clearly labeled on the
TVP7000EVM silkscreen. The primary test point headers for the TVP7000 are H2, H3, and H4
which provide access to the RED, GREEN, and BLUE data, respectively.

There are two jumpers on the TVP7000 board that configure the power-down mode and I°C
address select. Each jumper is set by default in its preferred state for the TVP7000EVM.
Around each jumper on the TVP7000 board is a silkscreen that describes the two states of the
jumper configuration.

Table 2. TVP7000 I°C Address Selection Jumper (12C ADDR)

12C ADDR
1-2 0xB8 (default)
2-3 OxBA

Table 3. Power-Down Mode Selection Jumper (PWDN)

PWDN
1-2 Normal Operation (default)
2-3 Power Down

NOTE: Ifthe FC address is changed on either the TVP7000 board or the THS8200 board

while the TVP7000EVM is powered up, then that device will not recognize the new I°C address.
The reset button on the TVP7000EVM must be pressed and WinVCC must be reconfigured for
the new FC address.

TVP7000EVM User’'s Guide 5
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6

Common Board Interface

The TVP7000EVM uses a 120-pin connector to connect the TVP7000 board (P3) to the
THS8200 board (P2). This interface shares all common signals including the 1°C and the 5-V
supply. This modularizes the TVP7000 board and allows users to interface it to a variety of
other Texas Instruments products including DVI transmitters, video encoders, or to any other
platform that shares the same interface.

This connector shares all digital video data (R[9:0], G[9:0], and B[9:0]), all video clocks
(DCLK_OUT, VSYNC, and HSYNC), RESET, FC, and 5 V as mentioned above.

Component Analog Outputs

The THS8200 board provides component RGB or YPbPr analog outputs to a display monitor.
The configuration settings for the TVP7000EVM use the RGB color space for PC graphics and
the YPDbPr color space for video (480i — 1080p).

TVP7000EVM User’'s Guide
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3  System Level Description

The system block diagram illustrated in Figure 2 provides an example of how the
TVP7000EVM may be used for evaluation. Typically, an RGB or YPbPr component analog
input is provided by a graphics/video source such as a pattern generator or a DVD player.

The TVP7000EVM is configured with the provided 5-V supply and the parallel port cable. The
output is provided by the THS8200 triple DAC to convert the digital data from the TVP7000
back to analog. This analog output is then fed into a quality display monitor.

PC 5V
(12C ctrl) Supply
——>

Pb/B .
DVI Display

Quantum | > _
Video/Graphic P_r/R’ TVP7000EVM Monitor
Source i’
VS
—_—

Y/G

Figure 2. TVP7000EVM System Level Block Diagram

4  Required Hardware and Equipment

The required hardware and equipment necessary to use the TVP7000EVM are:

TVP7000EVM (provided)

Universal 5-V power supply (provided)

- Parallel cable (provided)

- Windows-based PC

- One cable with five BNC connectors (RGB, HS, VS)

- One cable with three BNC connectors (RGB or YPbPr)

-  Two DB15 PC cables

- Video source (pattern generator, Quantum generator, or DVD player)

- Display monitor that supports PC graphics and video up to 1080p

TVP7000EVM User’'s Guide 7
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Hardware Setup
Perform the following steps to set up the hardware for the TVP7000EVM:

1.

Connect the TVP7000 board and the THS8200 board using the 120-pin board
connector. This becomes the TVP7000EVM.

Connect a video or graphics source to the DB15 input connector and the RGB, HSYNC,
and VSYNC input connectors of the TVP7000 EVM.

Connect a DB15 cable and three BNC cables to the THS8200 board.
Connect the parallel port cable from the TVP7000EVM to the PC.

NOTE: There are footprints for a dc jack on the THS8200 board, but the default power
is provided by the TVP7000 board via the 120-pin connector, P3.

Connect the 5-V power supply to the dc jack on the TVP7000 board. A green LED on
each board should now be lit.

Software Installation

WinVCC is a Windows application that uses the PC parallel port to emulate FC, providing
access to each device on the I°C bus. WinVCC makes use of CMD files, a text editable file
that allows preset video setups to be programmed easily.

This feature allows the user to easily set multiple FC registers with the press of a button.
WinVCC also has property sheets for the TVP7000 which allow the user to control the I°C
registers with a GUI.

All necessary software for the TVP7000EVM is provided on the enclosed CD. Perform the
following steps to install WinVCC.:

1.
2.

4,

Explore the provided TVP7000EVM Software CD.

Install Port95NT.exe. This is the parallel port driver used by WinVCC. This driver must
be installed and the PC must be rebooted before WinVCC will operate correctly.

Install Setup.exe. Click Next at all prompts and click Finish to complete the installation
process. This will install WinVCC onto the PC. No reboot is required.

Run WinVCC.exe

NOTE: A shortcut to WinVCC should now be available on the desktop. WinVCC and
additional TVP7000 related documentation can also be found at Start->Programs->
TVP7000EVM Software to start WinVCC and to browse the documentation.

TVP7000EVM User’'s Guide
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7  WIinVCC Quick Start
Perform the following steps in order to get video out of the TVP7000EVM.

1. Once WInVCC is executed, the WinVCC Configuration screen appears. This dialog
box configures the FC bus. Next to TVP7000, select the TVP7000 and ensure the FC
address is set to 0xB8. This must match the I12C ADDR jumper on the TVP7000
board.

2. Next to THS8200, select the THS8200 and ensure the FC address is set to 0x40. This
must match the 12C ADDR jumper on the THS8200 board.

NOTE: If WinVCC is running and the TVP7000 or THS8200 board I°C address is
changed, then power must be cycled on the EVM.

Win¥CC Configuration

12C S¥STEM CONFIGURATION

| DEVICE FAMILY | SPECIFIC DEWICE | I2C SLAVE ADDR [w)

¥ID_DEC [~ DVB |NOT USED T @ Bih O Bah

[Wideo Decoder]

VID_ENC NOT USED ¥ o 40k O 42k

[ideo Encoder)

TVR7OOO T~ DB [TyProd0 x| & B8h C Boh
[idea and Graphics Digitizer]

THS8200 THS8200 - v 40h T 42h

HDTW/SDTV/RGE DAC)

PROGRAM OPTIONS

EMABLE | 12C Systern Test [after clicking K.
EMABLE | 12C Acknowledae Checking

EMABLE | Auto-Update from Device [when opening or selecting a window).

ok | Exit Program |

Figure 3. WinVCC — I°C Configuration Screen

3. Ensure that all other boxes are selected as “Not Used” and that all program options
buttons are set to ENABLE. Click OK.

4. |If there are no I°C communication issues, then the Main Screen window displays next.
If there are FC issues, then an 12C Test Report box displays. Completely exit out of
WinVCC, double-check the parallel port cable connections, cycle power on the
TVP7000EVM, and re-run WinVCC.

TVP7000EVM User’'s Guide 9
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5. Load the provided Initialize. CMD file into WinVCC by clicking on Tools -> System

Initialization -> Browse. The default directory is c:\\Program Files\Texas
Instruments\TVP7000EVM\Initialization.

%> Windows Video Control Center (Win¥CC v5.00c ) M=
File Edit Tools ‘Window Help

Figure 4. WinVCC - Main Screen

6. Click the “TVP7000 + THS8200_...” dataset in the window and then click the Program

Dataset button to initialize the TVP7000EVM.

System Initialization

Command File |C:\Program Files\T exas Instruments\wirt/CC4\TVP 7000 nitilization’ niialize.omd .
Command File Operations Bytes Per Block =
= Al eloa
REPLACE APPEND PROGRAM (G ko)
Selected Datazet Current Device(s) 1[! Sl
with Current Device Settings zing il
Device Settings to CMD File Selected D atazet Status

[ FReady Cloze

Datazet Descriptions

= TWETO00 o BME Inputs A
= TWP7000 - Switch to VEA Input

1
2
3
4 = TVPT000 - Video Formats - BHC Inputs

5 = TYP7000+THS8200_480p - 31.468Khz - 27 Mz [Z<PLL])

6 = TYPFO00+THS8200_57Ep 31.25khz - 27 MHz [2<PLL)

7 =TWP7000+THS8200_ 720p -B0Hz- 45khz - 74.25Mhz

8 = TWPTO00+THS8200_ 720p -50Hz- 37 Bkhz - 74 25Mhz

9= TYP7000+THS8200_1080i - B0Hz - 33.75 khz - 74.25Mhz

10 = TVP7O00+THSB200_1080i-50Hz - 28.125 Khz - 74.25Mhz

11 = TWP7O00+THS8200_1080p-60Hz 67.5KHz - 148.5MHz

12 = TVP7O00+THSE200_1080p-50Hz 56,25 KHz - 148.5MHz

13=

14 = TVP7000 + THSE200 VESA Formats- WGA Input @
1R = TWRFINNTHS AN RANedBeRnH .31 Blhe 25¢P1 L . 25 1 TRMH> IMMTRARM HS AS 2 5

Figure 5. WinVCC — System Initialization

7. With a graphics/iideo source provided at the BNC or DB15 connectors and with the
proper resolution configured, video should be viewable on the display monitor.

NOTE: To ensure the TVP7000 is working properly, go to Status and check the
HSYNC and VSYNC detection status. If using YPbPr inputs, then the SOG status
detection will also be beneficial.

10 TVP7000EVM User’'s Guide
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8  WinVCC in Depth

The following sections describe how to use WinVCC in depth. It discusses various features
and screens which the user may encounter while evaluating the TVP7000EVM.

8.1 Starting WinVCC

The Port95NT parallel port driver must be installed before using WinVCC. WinVCC may be
started by clicking on Start->All Programs->TVP7000EVM Software->WinVCC.

If the dialog box shown in Figure 6 is displayed, then it means one of two things:

1. WinVCC did not run to completion the last time it ran. In this case, click OK to exit the
program and restart WinVCC.

2. There is more than one instance of WinVCC running at the same time. In this case,
click OK to exit the program. Then, press CTRL-ALT-DELETE to bring up the Task
Manager. Select and click End Task on all occurrences of WinVCC or WinVCC
CONFIGURATION. Then restart WinVCC.

If the previous run of WinYCC4 was terminated abnarmally, click O and skart \WinWCC4 again, Otherwise, more than
one instance of WinWCC4 may be running! Click OF to close this program.  Then, press CH-alk-Delete, Highlight and
click. "End Task" ko terminate all instances of Windows Yideo Contral Center (or WINYCC4 Configuration).

A

Figure 6. WinVCC Multiple Occurrences Error Message

TVP7000EVM User’s Guide 11
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8.2

8.3

12

WinVCC Configuration Dialog Box

The WinvVCC Confi%uration dialog box, as seen in Figure 7, should now be visible. This dialog
box configures the I°C bus on the TVP7000EVM. All settings from this dialog box are stored in
the Windows registry and are restored the next time the program is started. After initial
installation, the TVP7000 Video and Graphics Digitizer drop down box will be set to TVP7000.

The I°C slave address for each device must match the °C slave address selected by jumpers
on the TVP7000EVM. These jumpers are set by the factory to use 0xB8 for the TVP7000 and
0x40 for the THS8200 triple DAC.

It is also important to ensure only the TVP7000 is selected when using the TVP7000EVM. All
Program Options must be enabled. Disabling these options is only required if you are
debugging a problem with the FC bus.

Clicking OK begins FC communication with the selected devices.

Win¥CC Configuration

12C 5YSTEM CONFIGURATION

| DEVICE FAMILY | SPECIFIC DEVICE | 12C SLAVE ADDR [w)
VID_DEC [ DWB  |[WOT USED - * BBh ( Bah

[Video Decader]
WID_ENC MOT USED - 40k 42k

[Wideo Encoder]
TYFYO00D [ CWE | TvPrOOOD - (¢ BBh  BEah

[\ideo and Graphics Digtizer)

THS8200 THS58200 A (+ 40h " 42h
[HDTY/SDTW/RGE DAC)

FROGRAM OFTIONS

EMABLE |2C System Test [after clicking 0K,
EMNABLE 12C Acknowledge Checking

EMABLE | Auto-Update from Device [when opening or selecting a windaow).

0k | E«it Program |

Figure 7. WinVCC I°C Address Configuration

I°’C System Test

The I°C system test of selected registers runs immediately after closing the WinVCC
Configuration dialog box with OK (unless the PC system test program options button was
disabled).

TVP7000EVM User’'s Guide
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If the FC system test passes, then only a PASS message will appear. If the test failed, then a
dialog box like Figure 8 appears. See Section 9, Troubleshooting, for details on how to resolve

this issue.
The I°C system test can be run at anytime by clicking Run System I2C Test in the Tools menu.

12C Test Report

[THS8200. FAILED - Read, Dev=0x42, Addr=0x05, Data=0=00 - Mizscompare [Wote 0=01]

TWF7000 FAILED - Read, Dev=0488, Addi=0+05, Data=0x00 - Miscompare [Wrate Ox04]

Figure 8. I°C System Failure

TVP7000EVM User’'s Guide 13



Jﬁ? TEXAS
SLEUO066 INSTRUMENTS

8.4 Main Menu

After configuring the I°C, the main menu is displayed as shown in Figure 9. The menus, which
are used to operate WinVCC, are File, Edit, Tools, Window, and Help. The File menu’s only
function is Exit, which terminates the program. Table 4 summarizes the main menu contents.

*? Windows Video Control Center {WinVCC v5.00c )

File Edit Tools “Window Help

Figure 9. WinVCC - Main Screen

Table 4. Main Menu Summary

Menu Contents

File Exit
Edit Register Map

TVP7000PNP

Generic I°C Editor

Property Sheets

TVP7000PNP

Tools System Initialization

Real-time Polling

TV Tuner Control (FQ12xx series only)
Multiple-Byte I°C Transfers

Set I°C Bit Rate

Run System I°C Test

Run Continuous I°C Test

Read VBI FIFO

Capture Live VBI Data
Window Allows selection of the active window. Multiple windows can be open at the same time.
Help Displays program version

14 TVP7000EVM User’'s Guide
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8.4.1 System Initialization

Clicking System Initialization in the Tools menu displays the dialog box shown in Figure 10.

This dialog box provides the means for initializing the TVP7000 Triple ADC and/or THS8200 for
a particular video mode. The details of the initialization are contained in the command file (with

a CMD file extension).

The command file is loaded using the Browse... button. Once the command file is opened, a
text list displays descriptions of the individual data sets contained within the command file.

Click once on the desired data set description to select it. Click the Program Device(sg Using
Selected Dataset button to run the selected data set, which loads the devices via the I°C bus.

When the device initialization has completed, the status indicator reads Ready.

NOTE: If Ready does not display, then the devices are not initialized and the FC bus is not

communicating. See Section 9, Troubleshooting, for possible solutions.

Click the OK button to close the dialog box. Each time the System Initialization dialog box is

closed, the initialization file pathname and the data set selection number are saved in the
Windows™ registry to allow these settings to be retained for the next time WinVCC runs.

System Initialization

Command File |[:\Program Files\T exas Instruments\win/ CC4\TYP 7000 nifializationtlnitialize. cmd
Command File Operations Bytes Per Block i
i f eloal
REPLACE APPEND PROGRAM -y o] 4
Selected Datazet Current Device(s) 0 =
with Current Device Settings |Jzing Sl
Device Settings to CMD File Selected Dataset Shatus

| Ready Close

Datazet Deszcriptions

1 = TVPFO00 - Swaitch to BNC Inputs

2 =TWPF000 - Switch to VGEA Input

3=

4 = TWPF000 - Yideo Formats - BMC Inputs

5 =TWP7O00+THSE200_480p - 3.468Khz - 27 Mz [24PLL])

E=TWP7O00+THSE8200 5760 31.28khz - 27 MHz [Z<PLL]

T =TWPFO00+THS8200_ ¥20p -60Hz- 4Bkhe - 74.28kkz

8=TWPFO00+THS8200_ 720p -50Hz- 37 Bkhz - 74.25hhz

9=TYPFOO0+THSE200 10800 - B0Hz - 33.75 Khz - 74.25khz

10 = TWP7O00+TH58200_1080i-50Hz - 281256 Khz - 74. 25khz

11 = TWP7000+TH58200_1080p-E0Hz 67.5KHz - 148.5MHz

12 = TWP7O00+TH53200_1080p-50Hz 56.25 KHz - 148.5MHz

e

14 = TWPT000 + THS8200WESA Formats- WEA Input 3
1R = TWPFNMN+THS AN RdMedRNeFNH =21 Flkhe -22P1H - 2R 17RMH =z IMMTRERM HS AMS WL £

Figure 10. System Initialization

8.4.1.1 Adding a Custom Data Set

After programming the EVM via the System Initialization tool using the factory-supplied

command file through the Property Sheets tool, you can customize the device register settings

to suit your needs. Perform the following steps to save your custom settings:

TVP7000EVM User’'s Guide
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Reopen the System Initialization dialog box via the Tools menu.

2. Click the Append Current Device Settings to Command File button. A dialog box
requesting a description of the new data set appears.

Optionally, click the drop-down box and select one of the existing descriptions.
Modify the description text or type your own description.

Click OK. All nondefault register values from the TVP7000 and THS8200 are appended
to the current command file as an additional data set.

Now, you can select your custom data set and send it with a press of the Program... button.
NOTE: The command file ((CMD) must be saved as plain text.

8.4.1.2 Command Files

16

The command file is a text file that can be generated using any common editor; however, it
must be saved as plain text. Command files are especially useful for quickly switching between
the various system configurations. These .CMD files are unrelated to the typical Windows
.CMD files.

A default command file has been provided on the CD. This command file contains most of the
desired setups. This command file is located at:

c:\Program Files\Texas Instruments\WinVCC\TVP7000\Initialization Files\Initialize.cmd

A command file can contain up to 250 data sets. A data set is a set of register settings to
initialize the TVP7000 Triple ADC and/or THS8200 for a particular video mode. Each data set
includes a description that is displayed in one row of the dataset descriptions list. The register
settings may be located in the command file itself and/or may be stored in separate include
file(s) (with an .INC file extension) and be included into the command file using the INCLUDE
statement.
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8.4.1.3 Example Command File

An example of one data set within a command file is shown below.

BEG N_DATASET

/1 TVP7000 | 2C register settings
WR_REG TVP7000, 0x01, 0x01, 0x69 //
VR_REG, TVP7000, 0x01, 0x02, 0x00 //
WR_REG TVP7000, 0x01, 0x03, 0x58 //

_REG TVP7000, 0x01, 0x04, 0xh9 //
G TVP7000, 0x01, 0x05, 0x06 //
G TVP7000, 0x01, 0x06, 0x10 //
G, TVP7000, 0x01, OxOF, OXOE //
G TVP7000, 0x01, 0x10, 0x80 //
G TVP7000, 0x01, 0x19, OXAA //
G TVP7000, 0x01, Ox1A, 0x80 //
G TVP7000, 0x01, Ox1E, Ox1F //
G TVP7000, 0x01, Ox1F, Ox1F //
G TVP7000, 0x01, 0x20, Ox1F //
G, TVP7000, 0x01, 0x21, 0x08 //
G TVP7000, 0x01, 0x26, 0x80 //
G, TVP7000, 0x01, 0x28, 0x73 //
G TVP7000, 0x01, 0x2A, 0x07 //
G TVP7000, 0x01, 0x2B, 0x00 //
G TVP7000, 0x01, 0x2C, 0x50 //
G, TVP7000, 0x01, 0x31, 0x18 //
MR_REG TVP7000, 0x01, 0x07, 0x40 //
WR_REG TVP7000, 0x01, OxOE, 0x00 //

ARAAR

27

ARAA

33333333333333333
LE 3

AR

/1 THS8200 |2C regi ster settings
WR_REG THS8200, 0x01, 0x03, OxC1 //
WR_REG THS8200, 0x01, 0x19, 0x03 //
WR_REG THS8200, 0x01, 0x1C, 0x70 //
_REG THS8200, 0x01, 0x34, 0x03 //
G, THS8200, 0x01, 0x35, 0x48 //
G, THS8200, 0x01, 0x36, 0x80 //
G, THS8200, 0x01, 0x37, 0x02 //
G THS8200, 0x01, 0x38, 0x87 //
G THS8200, 0x01, 0x39, Ox11 //
G, THS8200, 0x01, Ox3A, 0xf4 //
G, THS8200, 0x01, 0x3B, 0xf4 //
G, THS8200, 0x01, 0x3C, 0x80 //
G, THS8200, 0x01, Ox4A, 0x00 //
G THS8200, 0x01, Ox4F, 0x00 //
G, THS8200, 0x01, 0x70, 0x40 //
G, THS8200, 0x01, 0x71, 0x03 //
G, THS8200, 0x01, 0x72, Ox1f //
G THS8200, 0x01, 0x73, 0x04 //
G, THS8200, 0x01, 0x74, 0x00 //
G, THS8200, 0x01, 0x75, 0x01 //
G, THS8200, 0x01, 0x76, 0x00 //
G THS8200, 0x01, 0x77, 0x07 //
G, THS8200, 0x01, 0x78, OXFF //
G, THS8200, 0x01, 0x79, 0x00 //
G, THS8200, 0x01, Ox7A, 0x29 //
WR_REG, THS8200, 0x01, 0x7B, 0x00 //
WR_REG THS8200, 0x01, 0x7C, 0x00 //
WR_REG THS8200, 0x01, 0x82, 0x40 //

ARAR

F:

333333333333 33333333373,

ARARAARAAAARRAAR

END_DATASET

DATASET_NAME, " TVP7000+THS8200_640x480x75Hz- 37.5khz - 2XPLL - 31.5MHz (DMB75)

HS/ VSi n"

PLL DI VMVSB
PLL DI VLSB
PLL CONTROL
PHASE SEL(5) CKDI CKDI DI V2
CLAMP START

CLAMP W DTH

PLL and CLAMP CONTRCL bit0 (0=
SOG Threshol d- (RGB d anmp)

| NPUT MUX SELECT RGB CH3 sel ected

I NPUT MUX SELECT HSYNC A and VSYNC A sel ect ed
CQOARSE OFFSET BLUE

COARSE OFFSET GREEN

COARSE OFFSET BLUE

HSOUT START

ALC RED and GREEN LSB

AL FI LTER Contr ol

Enabl e FI NE CLAMP CONTRCL

POAER CONTRCL- SOG ON

ADC Set up

ALC PLACEMENT

HSYNC QUTPUT WDTH - 64

SYNC CONTROL  HSout -

1680 - 2x

HSPO by chi p)

chip_ctl
csc_offset3
dman_cnt |

dtg_total _pixel _nsb
dtg_total _pixel_Isb
dtg_l i necnt_nsb
dtg_linecnt_lsb

dt g_node
dtg_frame_field_nsb
dtg_frame_size | sb
dtg_field_size |sh
dt g_vesa_char_si ze

csm node
dtg_hlength_| sb
dtg_hdly_msb
dtg_hdly_Isb
dtg_vlength_l sb
dtg_vdly_nsb
dtg_vdly_|Isb

dt g_vl engt h2_| sb
dtg_vdl y2_nsb
dtg_vdly2_|sb
dtg_hs_in_dly_msb
dtg hs_in_ dly |sb
dtg_vs_in_dly msb
dtg_vs_in_dly_|sb
pol _cntl

Each command file may contain individual write-to-register (WR_REG) commands.

TVP7000EVM User’'s Guide
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P WD

The comment indicator is the double-slash //.
The command file is not case-sensitive and ignores all white-space characters.
All numbers can be entered as hexadecimal (beginning with 0x) or as decimal.

Every data set in a command file begins with BEGIN_DATASET and ends with
END_DATASET. The maximum number of datasets is 250.

The dataset text description is entered between double quotes using the DATASET_NAME
command. The enclosed text can be up to 128 characters in length. This text appears in the
System Initialization dialog box when the command file is opened.

The INCLUDE command inserts the contents of an include file (with an .INC file extension)
in-line in place of the INCLUDE command. Therefore, the include file must not contain the
BEGIN_DATASET, END_DATASET, and DATASET_NAME commands.

NOTE: All included files must be located in the same directory as the command (CMD)
file.

The write-to-register command is written as follows:

WR_REG, <DeviceFamily>, <Number of data bytes (N)>, <subaddress>,
<Datal>,..., <DataN>

or

WR_REG, <Literal slave address>, <Number of data bytes (N)>, <subaddress>,
<Datal>,..., <DataN>

The valid device family mnemonics are:
VID_DEC for the video decoders
VID_ENC for the video encoders
THS8200 for the THS8200 device

WinVCC translates the device family mnemonic to the slave address that was selected
in the WinVCC Configuration dialog box upon program startup. This eliminates having to
edit command files if the alternate slave address must be used.

If the literal slave address method is used, then the slave address entered will be used
directly. This method is normally used for programming the video encoder.

8. A delay may be inserted between commands using the WAIT command, which is written as

follows:

WAIT,<# milliseconds>
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8.4.2 Register Editing

The next section describes the four available modes of register editing: Register Map Editor,
Encoder Module Editor, Generic 12C Register Editor, and Property Sheets. Each of these
functions can be selected from the Edit menu.

8.4.2.1 Register Map Editor

The register map editor, as shown in Figure 11, allows the display and editing of the entire
used register space of the device within a simple scrolling text box. To open this, click on Edit
Register Map in the Edit menu and click on the device type to edit. If the intended device type
is not shown, then use the Windows menu to activate the existing window.

TYPTOO0 (DB E) Register Map

| Addiess | Diala | RAW | Mame | Cipsenpdnn | -
R CHIF REXISION

A& FLLDIYIDE MZE

AAy FLLOIYIDE L=E

RAY PLLCOMTAOL

FH&SE SELECT

RAY CLAWPSTART

R CLaMPWIDTH

RA¥ HEYHC OUTFUTWIDTH

RAs BLU FIME SAIN e

HIIITE”'I.Aru uhdl:ss mt sh.nnn it bisk can be sccesesd by (pping be sddeers and (hen chcking Resd o Wiis

EEEE=2=23938:
-
S

Leop Count Flad:
Lzl i 1 ApplaE ol | i
| s ) and Fimad bitors, Dec
ET | [1-933 Hex &
A Fiead  Hi on Loap Do Fleads |
=
: AHD |
| :]I Fzad &1 I Erakle Mak: kE E Ooze

Figure 11. TVP7000 Register Map

Figure 12 is the THS8200 register map.

TH5B200 [ted 2] Repister Map

| addiess | Daks | AAW | Hame | Descnplion [~
R SN

A chip_oi

AMY c=c_nel

RA o il

cE_ED

A ool

AMY cmc_ncd

R cae el

RAY  cee gl o

HUTE"L.D.ruaE\:I.‘u.ss rick zhavniin the Bsl can be soosssed by luming the addisss srd then chicking Resd orinis.

EEE8=2235=
X
£

Loop Court  Fadi
A e bl A
oI C TS (O - o
i 15581 Hex =
Faad | Hishooram o Loop Count Read: =

i -— AHD [/
| : 1 Read All Ehels Wask 3 M oz

Figure 12. THS8200 Register Map
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Table 5. Register Map Editor Controls

Control

Definition

Register Window

Scrolling text box that displays the address and data for the I°C registers that are defined for
the device.

Address Edit Box

This contains the I°C subaddress that will be accessed using the Write and Read buttons.
Clicking on a row selects an address, which then appears in the address edit box.

NOTE: After clicking on a row, the Data Edit box contains the data that was in the register
window. The device has not yet been read.

The address up/down arrows are used to jump to the next/previous subaddress that is
defined for the device. If an address is not defined for the device, then it can still be
accessed by typing the subaddress in the Address Edit box.

Data Edit Box

This contains the data which will be written to or was read from the I°C subaddress.
The data up/down arrows increment/decrement the data value by 1.

Write Button

Writes the byte in the Data Edit box to the address in the Address Edit box.

The I’C register is written to whether or not the data is different from the last time the
register was read.

Read Button

Reads the data from the address in the Address Edit box into the Data Edit box and the
register window.

Read All Button

Reads all defined readable registers from the device and updates the register window.

Hex Button

Converts all values in the register window and address and data edit boxes to hexadecimal.

Dec Button

Converts all values in the register window and address and data edit boxes to decim al.

Close Button

Closes the dialog.

NOTE: Multiple edit register map windows can be open at the same time (one for each
device). Use the Window menu to navigate.

Loop Count

Causes subsequent write or read operations to be performed N times. N is entered as a
decimal number from 1 to 999.

Edit Indirect Registers

Opens the indirect register editor of the TVP7000.
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8.4.2.2 Generic I°C Register Editor

The Generic I12C Register Editor, see Figure 13, allows the display and editing of any device on
the FC bus. This editor works like the Register Map Editor, except that the FC slave address
must be entered and the Read All button is disabled.

To open this, click on Edit Register Map in the Edit menu and then click on Generic 12C.

Generic |12C Register Map

| Addiess | Dola | AAw [ Mame | Desengion | s
oo R
m - R
o2 - Rie
(K] . R
|04 - R
ns RAY
| 0B - RAY
o7 - RAY
T i Rt 3
12C Slave
A
— .
Lles Repeeatad Sl L ;
e i .::uunl Applas lowita [ Radk
[ = ) and Aeed bublors Dex:
; 1 - 23) Her &
e R | Hiztogram on Loap Do Fleads |
o) ———
- AHD
| :jl Azod LIk [LE=S £ ﬂ Close

Figure 13. Generic I°C Register Editor
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8.5

8.5.1

22

TVP7000 Property Sheets

The property sheets represent the register data in a user-friendly format. The data is organized
by function, with each function having its own page and being selectable via tabs at the top.

To open this, click on Edit Property Sheets in the Edit menu and select the device type to edit.

When the property sheet function is started or whenever you tab to a different page, all
readable registers in the device are read from hardware to initialize the dialog pages. Values
on the page are changed by manipulating the various dialog controls.

There are OK, Cancel, and Apply buttons at the bottom of each property page.

With the TVP7000, there are six different tabs available within its property sheets. The tabs are
organized by the TVP7000 functions. The following subsections describe the additional details
and recommendations of the controls within each tab.

Input Mux

Auto detect is recommended for HSYNC/VSYNC selection and HSYNC input polarity. The
TVP7000 automatically senses the presence of SOG and discrete HSYNC and VSYNC inputs.
If SOG and discrete syncs are both present, then the TVP7000 automatically selects and uses
the discrete syncs. Input sync status is available in the sync detect status FFC register (14h)
and can be viewed using the status property sheet. The BNC on the TVP7000 EVM inputs
must be used for SOG operation.

SOG threshold (register 10h) sets the voltage level of the SOG slicer comparator. Each step
represents an 11-mV change in slice level. A middle range setting of 10h is recommended.

T¥P7000 (0xB8) Property Sheets

Input bus ] Clamp Control] FLL I Gain and foset] Dutput] Status]
HSYMC Selection HSYMC Input Palarity WSYHNC Selection
" HEYNC " Active Low 7 WEYNC
" S0G " Active High " Sync Sep
* Auto Detect * Ao Detect * Auto Detect
SOG Threshold Sync Seperator Threzhold
16 ﬁ ] i‘
[0-31] [0-255]
Read Al
oK | Cancel ‘ Apply ‘

Figure 14. Input Mux — Property Sheet
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8.5.2 Clamp

Most ac-coupled video applications use the internally-generated clamp pulse for dc restoration
prior to the ADCs. The fine clamp must be enabled for all three channels and correctly
positioned during the horizontal blanking interval. The fine clamp start (FC register 05h) is
relative to HSYNC trailing or leading edge depending on the clamp REF bit setting in FC
register 15h. See Figure 15 for recommended clamp placement settings for various input
formats.

Bi-level Sync

Internal
.L..:r-CIamp

N y
Tri-level Sync L o R

A

A

E Typical Settings Clamp Start Clamp Width ALC Pacement

Fine Clamp Start (Reg 05h) J / ‘"""""!"_“' HDTV (tri-level) 50 (32h) 32 (20n) 90 (5Ah)
Clamp Start + Clamp Width (Reg 06h) H SDTV (bi-level) 6 (06h) 16 (10h) 24 (18h)
/ ,-"" PC Graphics 6 (06h) 16 (10h) 24 (18h)
ALC Placement (Reg 31h) f.r"
E
ALC horizontal filter (Reg 28h) -—--——-----"‘.

1to 1/128 ( 1/N where N = pixels averaged)

Figure 15. Clamp Placement

Placement is relative to end of negative SYNC tip. ALC horizontal filter may be limited by back
porch area for some formats.

Either bottom or middle level clamping can be selected. These must be set according to the
video input format. Bottom level clamping must be used for Y and RGB inputs. Middle level
clamping must be used for Pb and Pr inputs. Coarse clamp must be left disabled for most
applications. A typical clamp setup for RGB graphics is shown in Table 6 and Figure 16.

Clamp charge pump current must be left on highest setting. Clamp polarity is only effective
when an external clamp is used.
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Table 6. Typical Clamp Setup for RGB Graphics
| 2C Address Setting Descri ption
05h 06h Clamp start
06h 10h Canp width
OFh OEh Internal C anp enabl ed
10h 80h Bottom | evel clanping for RGB
15h 00h Clanmp pulse relative to HSYN trailing edge
2Ah 07h Enabl e fine cl anps
2Dh 00h Coarse O anp di sabl ed

T¥P7000 (0xB8) Property Sheets

Input Mux  Clamp Control ] FLL I Gain and Offzet ] Output ] Status]

Course Clamp Enables

Fire Clarnp Enables

Clarnping Lewvel

R/Fr MIDDLE

R/Pr R/Pr ¥
G GAY W GAY BOTTOM
B/Fb [ B/Pb W E/Ft MIDDLE
-CLAMP Pulze Placement wit-— )
CLAKP Start Pixel
7 HSYMC Traling Edge -
CLAMP Sowce  INTERNAL 162
4] " HSYMC Leading Edge . j
[0 - 255 pixelz]
CL&MP Charge Purnp Current CLAMP Polarity CLAMP "idth
00 (Highest) | & Ackive High 16 i‘
7 Active Law [0 - 255 pinelz]
Read &l
oK | Cancel ‘ Apply \

Figure 16. Clamp Control — Property Sheet

8.5.3 PLL

24

The feedback divider is typically set to the total number of 2pixels per line. A 2x feedback

divider value can be used if the DIV2 bit (DATACLK/2) in |

C register 04h is setto 1. This can

offer improved jitter performance, when low pixel rate formats are used. The pixel clock rate is
derived from the HSYNC input frequency, feedback divider, and the DIV2 bit.
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TVPF000 (0xBB) Property Sheets

InputMux] Clamp Control - PLL ]Gain ahd foset] Dutpul] Status1

—&A0C Clock Freg Contral -

ADC Clock Freq
tHz
(1.0 - 265.0) Program Feedback Feedback Divider
R N R
g
HEYME Freg and HSYMC Freg (0 - 4095)
1 KHz values
[1.0-285.0)
[Mot a regizter)

Charge Pump Current
10 hd

ADC Clock Phase Caontrol

0 180 360 Sweep
; i WL Range
————— — [ 2475 deg) [Low -

[ Free Run

COAST Source  INTERMAL

—COAST Polarity -

" Active Low
" Active High
+ Auto Detect

~ COAST Timing
Pre-Coazt 0 [0-255 HSYMCz)

Past-Coast 12 [0-255 HSYMCs)

Read &l

0K | Cancel |

Apply |

Figure 17. PLL —Property Sheet

An internally- or externally-generated coast signal can be used to put the PLL in coast or free-
run mode to avoid disruptions in HSYNC during vertical blanking. When the internal coast is in

use, the pre-coast and post-coast settings specify the coast interval range relative to the

internally-detected VSYNC. Pre-coast specifies the number of lines before detecting VSYNC,

and post-coast specifies the number of lines after VSYNC that are used for the coast interval.
Additional post-coast lines are required when Macrovision is present on the video input. The

MAC_EN bit in I°C register 22h must be set to 1 for Macrovision compatibility. External coast
must be enabled when discrete HSYNC and VSYNC are used.

Table 7. Recommended Coast Settings

Format Pre-Coast Post-Coast
480i/p with Macrovision 03h 0Ch
576i/p 03h 0Ch
1080i 03h 00h
1080p 00h 00h
720p 00h 00h
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8.5.4 Gain and Offset—ALC

26

Stable output offset levels are maintained by use of the ALC feedback level control in the
TVP7000. Two sets of filter coefficients are available that define the level of filtering applied on
each line (horizontal) and the amount of feedback correction that is applied per line update
(vertical). The horizontal coefficient (register 28h, NSH[2:1]) specifies the number of pixels that
are used in the horizontal filter. The ALC filter must be applied during the horizontal blank
interval following the clamp pulse, so it must be correctly positioned using the ALC placement
register (register 31h). NSH coefficients range from 1 to 1/N, where N is the number of pixels
used in the filter. The amount of horizontal filtering that can used will depend on the ALC
placement and the horizontal blanking interval of the input video format. See Table 8 for
recommended ALC placement settings.

The vertical coefficient (register 28h, NSV[3:0]) specifies the amount of feedback error
correction derived from the horizontal filter that is applied to each line update. The NSV
coefficient can range from 1 (maximum error applied) to 1/32768 (minimum error applied).

The ALC must be enabled by setting bit 7 of °C register 26h to 1. In the ALC operating mode,
the fine offset registers are used to position the digital output levels. The coarse offset levels
must be set to 1Fh and left unchanged for optimum ALC performance. Fine offset settings are
relative to the bottom level (ADC code 0) for bottom-clamped signals and the middle level (ADC
code 512) for middle-clamped signals.

Table 8. Typical ALC Setup for RGB Graphics

Address Setting Description
05h 06h Clamp Start
06h 10h Clamp Width
0Bh 80h Blue Fine Offset
0Ch 80h Green Fine Offset
0Dh 80h Red Fine Offset
26h 80h Enable ALC
28h 73h ALC Filter
31h 18h ALC Placement
1Eh 1Fh Coarse Offset Blue
1Fh 1Fh Coarse Offset Green
20h 1Fh Coarse Offset Blue
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T¥P7000 (0xB8) Property Sheets

Input Mu:-:] Clamp Control] FLL Gain and Offset l Output 1 Statusl

— Coarze [Analog) Gain- =1 Fire [Digital] G ain-

5} 10 15 i} 128 265 Default
R————[ s A i [28
s b [ 5 | e

5}
P ————— : | e
~ Coarze [f&nalog) Offset-  Fine [Digital] Offzet -

B i] el Drefault 512 0 511 Default
H = ||fr—F—T
G _| 3 g _J| [t
B _] [ = B _J| o

[ Lock red and blue sliders to green slider

— Automatic Level Control [ALC)

EMNABLED

ALEC Flacement
2 i—-]

[0-255]

~ALC Filker Coefficients -

Harizontal
1/8 -

Wertical

1 -
Fead All

0K ] Cancel ‘ Apply 1

Figure 18. Gain and Offset — Property Sheet

TVPF000 (0xBB) Property Sheets

|t Mu:-c] Clarp Eonlrol] PLL ] Gain and Offzet  Qutput l Statusi

— Dutput Format -

" 444 HSYMNC Dutput Polarity HS¥MNC Out Start
402 ACTIVE HIGH g ﬁ ™ Power Down

[0 - 285 pixelz]

 Dutput Order-
* Cr,Ch

i Ch,Cr

HSYME Out Width

=

[0 - 255 pixelz]

WEYMC Output Polarity

MNOT INWERTED
Read &l

0K ‘ Cancel 1 Apply ‘

Figure 19. Output — Property Sheet
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T¥P7000 (0xB8) Property Sheets

InputMux] Clamp Contml] FLL ] Gain and foset] Output Status l
HSYME Input Status “WEYNE Input Status
MOT DETECTED MOT DETECTED
ACTIWE HIGH ACTIWE HIGH
FROM HSYMC ] FROM SvMC SEF
SOG Input Stabus - COAST Input Status
MOT DETECTED ACTIWE HIGH
Chip Revizion
l_‘_“‘_D‘D“—“ Read Al
0K I Cancel | Apply ]

Figure 20. Status — Property Sheet

8.5.4.1 Reading the Register Map

The property sheets were designed so that the data displayed is always current. Certain
actions cause the entire register map to be read from the device and to update the property
sheets. This happens when:

1. Property sheets are initially opened.

2. When tabbing from one page to another.

3. When Read All is clicked.

4. When making the Property Sheets window the active window (by clicking on it).
5

When making a Register Map Editor window the active window (by clicking on it).
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8.5.4.2 Auto-Update from Device

Items 4 and 5 above are referred to as the Auto-Update feature. Auto-Update can be disabled
by setting its program option button to DISABLED. This button is located on the initial dialog

box (WinVCC Configuration).

With Auto-Update enabled (default), the user can open both the Property Sheets and the
Register Map Editor at the same time. Changes made to the Property Sheets (and applied) are
updated in the register map window as soon as the Register Map window is clicked on. It also
works the other way; changes made in the Register Map Editor are updated in the Property

Sheets as soon as the Property Sheets window is clicked on.

Table 9.

Use of Property Sheet Controls

Dialog Control

What Do | Do With It?

When is Hardware Updated?

Read-Only Edit Box

Read status information

N/A

Check Box Toggle a single bit After Apply
Drop-Down List Select from a text list After Apply
Edit Box Type a number After Apply

Edit Box with Up/Down arrows

Use up/down arrows or type a number

Up/Down Arrows: Immediately
Type a number: After Apply

Slider

Slide a lever

Immediately

Pushbutton

Initiate an action

Immediately

Table 10. Property Sheet Button Controls

Button Control

Definition

OK Writes to all writeable registers whose data has changed. A register is flagged as

changed if the value to be written is different from the value last read from that address.
Closes the dialog.

Cancel

Causes all changes made to the property page since the last Apply to be discarded.
Changes made to dialog controls with ‘immediate hardware update’ are not discarded,
since they have already been changed in hardware.
Does not write to hardware.

Closes the dialog.

Apply

Writes to all writeable registers whose data has changed. A register is flagged as
changed if the value to be written is different from the value last read from that address.
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Troubleshooting

This chapter discusses ways to troubleshoot the TVP7000EVM.

Troubleshooting Guide

If you are experiencing problems with the TVP7000EVM hardware or the WinVCC software,
see Table 11 for available solutions.

Table 11.

TVP7000EVM Troubleshooting

Symptom

Cause

Solution

At startup, the error message
Cannot find DLL file

DLPORTIO.DLL appears.

The parallel port driver supplied with
the EVM has not been installed.

Run Port95NT.EXE on the CD to
install the driver.

Blank screen

Wrong analog input is selected.

Go to Edit->Property Sheets-
>TVP7000, Analog Video page,
select the correct video input(s) and
click Apply.

(The Composite Video 1 input is
default.)

Source is connected to the wrong input
connector.

Connect source to the correct input
connector.

Vertical Stability Or Flashing
display

Mode detect issue due to
HSYNC/VSYNC alignment

Adjust HSYNC output delay

Line Noise present with High
Frequency vertical line input

pattern

PLL phase setting is not set correctly
for the input source

Adjust PLL phase setting

Line noise present with flat field

Excessive noise on the input source

Filter the inputs or try a different
source

Picture too dark

Clamp or ALC not set correctly

Reposition Clamp or ALC. Reduce
ALC horizontal filter coefficient

SOG/Y does not work

SOG clamp disabled

Set SOG_CE bitinregister 2Eh to 1.

SOG does not work when using
the VGA connector

The VGA input is not connected to an
SOG input pin

The BNC connectors must be used
for SOG operation
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Table 12. I°C Troubleshooting
Symptom Cause Solution
No I°’C I°C slave address is wrong. Close and restart WinVCC. Choose the alternate slave

communication

address in the WinVCC Configuration dialog.

Parallel cable is not connected from PC
parallel port to the EVM DB25 connector.

Connect cable.

EVM is not powered on.

The power supply must be plugged into a 100-V to 240-V/
47-Hz to 63-Hz power source and the cord must be plugged
into the power connector on the EVM.

Wrong type of parallel cable.

Some parallel cables are not wired straight through pin-for-
pin. Use the cable supplied with the EVM.

PC parallel port mode is not set correctly.

Reboot PC, enter BIOS setup program, set parallel port
LPT1 mode (address 378h) to ECP mode or bidirectional
mode (sometimes called PS/2 mode or byte mode). If
already set to one of these two modes, switch to the other
setting.

See Section 4.2.1.

Device was placed in power—down mode.

Press the reset button on the TVP7000EVM.

EVM was configured for an external I’c
master.

Reinstall 0-? resistors R5 and R6. Control EVM using the
PC parallel port.

Still no I’C communication

The PC may not be capable of operating in the required
parallel port mode. This is true of some laptop computers.

Use a different computer, preferably a desktop PC.

When WinVCC is started and the WinVCC Configuration dialog box is closed with OK, the FC
system test is performed (unless the 12C System Test program options button was disabled).
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If the FC system test fails, a dialog box will appear. Figure 21 reports that a read from
TVP7000 failed, using slave address 0xB8, subaddress 0x05. The data read was 0x00.

After noting which device had a problem, click OK to continue. Next, the Corrective Action
Dialog box appears to help fix the problem.

12C Test Report

[TH38200...FAILED - Read, Dev=0x42, Addr=0x05, D ata=0x00 - Miscampare [wrate 0x01)

TWP7000.. FAILED - Read, Dev=0xB8, Addr=0+05, Data=0x00 - Miscompare [Wiate Dx04]

Figure 21. I°C System Failure Dialog Box
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9.2 Corrective Action Dialogs
After closing the I°C system test report dialog box, the dialog box in Figure 22 appears.

!'j 15 a parallel cable connected from the computer's LPT1 park ko the evaluation module (EYM) and power applied ko the
. ENM 7

Figure 22. Corrective Action Dialog Box

1. If the parallel port cable is NOT connected between to PC and the TVP7000EVM or if the
EVM power is not on, then:

a. Click NO.
b. The dialog box shown in Figure 23 appears instructing you to correct the problem.

c. Correct the problem.
d. Click OK to continue

WinVCC4

! E Connect a parallel cable from the computer's LPT1 part to the E¥M and apply power to the EYM, Then, click Ok,

Figure 23. Corrective Action Required
2. Ifthe cable is connected from the PC parallel port to the TVP7000EVM and the EVM power is
on:
a. Click Yes.

b. The dialog box shown in Figure 24 appears. This dialog box appears if the PC parallel
port mode setting may need to be changed.

NOTE: Only run the PC BIOS setup program if the FC communication problem cannot be
resolved in another way (correct slave address settings, reset or power cycle the EVM, and/or
check that the device type selected was TVP7000).

c. Click OK to continue.
d. Click OK to close it and get to the main menu.
e. Click Exit in the File menu to exit the program.
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f. See troubleshooting guide above.

WinV¥CC4 [g]

'j This program MaY MOT work with the current parallel port mode setting in BIOS. IF the I2C communication problem
! CAMNOT BE RESOLYED IM AMNOTHER WY (Correct device bype andjor slave address setkings, reset or power cycle
the EVM.), restart this computer and enter the BIOS setup program. Change the LPT1 parallel port | base address:
0378 ) ko ECP mode or to BI-DIRECTIONAL mode {also called PS/2 mode or BYTE mode). IF one of these bwo modes
is already selected, change to the oppaosite mode,

The fFollowing parallel port modes were Found to be Functional; ECP:Bidirectional + SPP + BI-DIRECTIORAL.

Figure 24. Corrective Action Required

9.2.1 Setting the PC Parallel Port Mode

NOTE: Only run the PC BIOS setup program if the FC communication problem cannot be
resolved in another way (correct slave address settings, reset or power cycle the EVM, and/or
check that the device type selected was TVP7000).

1. Restart the PC.

2. During the boot process, enter the BIOS setup program by pressing the required key
(usually the initial text screen tells you which key to press).

3. Find the place where the parallel port settings are made.

Set the parallel port LPT1 at address 378h to ECP mode or bidirectional mode (sometimes
called PS/2 mode or byte mode). If one of these two modes is already selected, then
change to the opposite mode.

5. Exit and save changes.

9.2.2 General I°C Error Report

The error report shown in Figure 25 appears when an FFC error occurs at any time other than
after the PC system test. In this example, there was an acknowledge error at slave address
0x54 (the video Triple ADC module). The error occurred on Read Cycle Phase 1 on the device

(slave) address byte.

I12C Error Report

Read. Devw=0x54, Addr=0x00, Data=0+00 - MO ACKN: RD1-DEY

[ Ignore |2C Acknowledge Enors E xit Pragram

Figure 25. I°C Error
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10 TVP7000EVM Schematics

This chapter contains the TVP7000EVM schematics.

TVP7000EVM User’'s Guide 35



THS8200EVM REV1_1

Y/G

Pb/B

Pr/R

12¢ Power
12C Power
= scL E
[Connector
Connector > SDA |—D CONN_RESET®
CONN_RE:
THS8200
THS8200 U
scL ScL ‘
SDA SDA B
&
GY[9.0] + > GY[9.0]
BCb[9..0] + > BCb[9.0]
RCr{9.. + > RCH9.0]
SCLK > SCLK
HSYNC > HSYNC ‘
VSYNC > VSYNC g 55
FID t { > FID @¥ 00
83 v
oo IT>
4< TEg X000 Tx EE
BB ogg gt $3 33
S85 “60 fg= T
g > g > I I I
Testpoints.
Testpoints.

Tille
THS8200 EVM REV 1.1 - Block Diagram

Size Number
C

Revision

REV 1.1

Dal Sep-2005 Shed 1016
File: NEVM Design FIleSTVP7000 EVM_|IOBUMIDEREV LOTVP7000EVM_RT

\THS82

00EVM_MODULE_REV1_2THS8200EVM_MODULE_REV1_2.ddb



3 4 6
['VP7000EVM Rev 1.0
D
12C
12C
Power
Power 1<
35
;
a [
['4
LIJ TVP7000 Connector
> TVP7000 Connector
RESETB > RESETB
[@
SCL SCL
Anti-Aliasing Filters EDR EDR
Anti-Aliasing Filters GJ9..0] [ s Glo.0]
B[9..0] [ + > B[9.0]
R[9..0] [ * > R[9.0]
DCLK > DCLK
HS t O HS
'S t > VS
5
o RS
o'lh <2
8 woJ
OO
B
Testpoints |
Testpoints UUUU U
a scL <_r——
5663 ! SDA
o< O
(Ll O] a
§ 00 G[9..0] _
B[9..0] <_¢
R[9..0] <_¢ [
HS <}
vs
A
Title
TVP7000EVM
Size Number Revision
B REV 1.1
Date: 3-Aug-2005 [ Sheet of
File: E:\\EVM Design Files\TVP7000_EVM_NIQPANEBREV1.0:TVP7000_ EVM_MODULE_REV1.0.ddb
3 4 6




D33V
[}
{
0.1uF 22 R24 R52
RS 22 2%
&
PL uzc u20
R6
6 9
7 Y SCL
DELS 74AHCOS 74AHCOS
o3¢
— 16 U2F
7 DBI7 13
DBY
e —
11 DB11
24
12
e —
5% ° SDA
SDA
DBZ RS3 R54 RS
& 22k 22k

ULE_R

EV1.0.ddb



1 2 3 4 5 6
POWER ON LED (+5V) 5V 3.0A DC INPUT
! RESET ON POWER UP
Dsv
D5V D33V o
Fl FUSE Tt
R18 R19
330 P2 Ny
P3002BH L 100k
D1 No Pop
No Pop U4 (3 e
1 8
=R SS26 CONTROL VDD
WED | HEADER 3 RESET S ResN T sense "
N RESET J_ 4 X
% C19
F
"%
C
L1 A33V
VOUT1 IS 3.3V 500mA -q
VOUT2 IS 1.8V 250mA iam: car c20
20F F
R2O
250
U3
v »X—— NC NC —5eX
1 VINIA VOUT1A
VINIB VOUT.
/MR VSENSELFB
JENL PGL
2] o JEN2 PG2 —X
JRESET —
GND VOUuT2A 1
1 2 VINZA VOUT:
vinzg & NC =X
TPS70251
2] o .
"%
B
PLL A1.8V 150mA
Dsv
T us
1 L3 PLLALBY
a out—=
GND o
BYPA &3 &
S en 20F F
TPS73L18 c
bt 00LF
A
ULE_REV10.ddb
1 2 3 4 5




SCL

o
o
<

3

o
3
<

<

SCL
SDA

FETTTTT
3
5

i TT?T******** 1 A
2

FPDAT/VSYA/M2
FFRSTW/CBFLAG
FSY/HCIHSYA/~BLNK
VGAV/SYNC_T
FFIE/CCVALID
FFWE/DVALID
FFRSTWIN/~SCLK
FFRE/DIG_H
FFOE/DIG_V

TTTTTTTTT

J‘Eﬁ%g

ekl LR K S g

LK

AVID
PREF[_DCLK

E

109
108
107
106
106
104
103
102
101
100

%

5

DCLK

ST&’ ESTE/F% 8 S|§E 8

SAMTEC_TMMS_120PIN_M_RA

Title
CONNECTOR
Size’ Number Revison
C REV 1.1

Date:

ULE_REV1.0.ddb




scL SDA

HS

Vs

SOG_OUTCLAMP COAST  TEST
HBOUT VBOUT S@G OUTChAMP CEAST T&ST
G G F F = F

—

[ VS

[506 ouT>—S0G OUT
[cLamP CLAMP.
[CoAST COAST
TS

DCLK

k D18 GND
AL8V D8V GAD
PLLALSV Pl D18V = !
- - =
AL8 D33
AR8Y Da3V
ALBV . D3.3V 8-
A33
A3.3V A&CN

H2
1 2 o—
3 40—
5 6 lo—1
7 80—
9) 10 o—4
un 12—
13 14 0—
5 16 0—4
17 18 0—
19 20—
HEADER 10X2
H3
1 2 o—
3 40—
5 60—
7 80—
9 10 0—9
un 12—
13 14 0—
5 16 o—
17 18 0—
19 20—
HEADER 10X2

2
4
6
8
10
12
14
16
18
20

HEADER 10X2

Title
TESTPOINTS
Size’ Number

ULE R

EV1.0.ddb



A33V

o Tk e ] aF
~

T e e " Jur

PLLALSV

_ﬁﬁ
!th [1uF

D18V
!m; Taur

DB1S
FBL
RIN 3
1T
B2
GIN 3
B3
BIN 3
HSYNC A
R1 220
7 VSYNC A
Ri3 20
R28 R0 RI12 R14
B S SB 30 30
DBISF ~
VSYNC
BNC_RA
- [ VSYNC B
220
RIO
30
HSYNC
BNC_RA
- 3 HSYNC B
220
RI6
30
GREEN
BNC RA P
1 2 GIN 1
T 1 R3L
of « 75
G AL IN] G FIL OUT]
BLUE
BNC RA 2
1 2 BIN 1
T 1 R32
of « 75
B FIL IN] B FIL OUT]

RED
BNCRA 3
2 RIN 1

1
T 1 R33
o < 75
RFIL_IN] R_FIL OUT]

12C ADDRESS SELECTION
2-3: Base Addr OXBA
1-2: Base Addr 0xB8 - Default

D33V
R26
10k
D33V
ol
12cA 2 on )
E—— V1]
PwDN 2 SR
. . V]
Ra7
VSYNC A 10k o
VSYNC B
HSYNC A
HSYNC B
6 ||owF FLT2
| FILTL
cs1 ||ane
GIN 3 o7 ||owr EXT CLK
A33V PLLALBY COAST
c2_||anE CLAMP
| 3
8 ||owF d
T
Eamsglgmalslgmglgmlg:%&mn s -
u1 o] RL/
Jeo0zeg8e80a8R80 05K asyS o =/
zzzzz P
o |e 530309553233 588532202283 o i/
soG|N1§ § 2222 %% <90 850856°° woa SDA 0 B
Soat S5 555522852 = SCL RS
GIN 1 co [0 AL8GND dd dad 12CA LA =
A18VDD ™S
A18GND RESETB EVEVSDFNF B RESARRAY_ISO_8
A18VDD PWDN &3
A18VDD DVDD £
RIN 3 c0 Jjour D M 0 %/
RIN_3 10GND = = G[9.0]
cu ||owr RIN2 10VDD 5
RIN 1 c12 ||oaud FINEL RO 0 12 o] %//
. AZIGND R1 i 2
A33VDD o R2 i) 2 &
A33VDD DGND R3 2 2 &
BIN 3 e Jjowr i Frd T4 /]
c1a ||owr BIN3 10GND 55 ouTS RESARRAY_ISO_8
BIN_2 R 5 —22 Sre
BIN 1 c15_||o.1urf BIN1 RE— ouT7
A18VDD R7 o
ALBGND R8s —2 quTs o/
NSUB Rol_5 T 1
TEST T 4 G§/]
V VS OUT Ny 06N> |5 O s
HS OUT S A - m—re 0 B0 L
x X
SOG oU eour % o s Goum QUTL 51/
[=Y-X°] =Y 2 B:
2 a o
oz Q002 3 B’
3852 oy~ oS 25 B o@~onaN
823 n'nn'n'n'n'n'a'n'adE 80 0'v'v''v''v'd e Ean
TVPT000
2|3 R
0 84/]
0 B5
0 B6,
A4 oUuT2 0 B7
QUT3 0 83/]
ouT4 0 B9
ouTs HS OU HS
S 3 HS
ouTs RESARRAY_ISO_8
ouTo
5 R38
o pork out BB, DOLK (DGR
e 499
oUT3
ouT4
St = T —
UL
Qs — RESETB
DCLK 0UT SO0G ouT e
= TEST
coast COAST
cLAMP SANE
RI9 JRAO
100 S10c

EXTCLK
SMA_PCB_MT_MOD
1 EXT CLK
R17
50

Title
TVP7000

Sze Number
C]

ULE_R

EV1.0.ddb



C49
NO POP

L6

[GFIL IN LYY Y

C56
NO POP

[RFIL_IN LYY Y

NO POP

—C57
NO POP

G FIL OUT >

C59
NO POP

C58
NO POP

L8
[B FIL_IN LYY Y

NO POP

—C61
NO POP

R FIL OUT)

C60
NO POP

NO POP

—C62
NO POP

B FIL OUT)

Title
RGB ANTI-ALIASING FILTERS
Size Number Revision
B REV 1.1
Date: 3-Aug-2005 [ Sheet of
File: E:\EVM Design Files\TVP7000_EVM_MQBANEBREVL.O\TVP7000_EVM_MO)

DULE_REV1.0.ddb

6




D3 3v
c
1
1l
0.1uF 2.2k R4 RS
R2 2.2k 2.2k
]
5
P3
R6
SscL =0
4 | o
5 DBI15
o3
o—1—16%¢
7 DBI7
8
9
0
DBY
DB11
D
SDA
DB25F R13 R14 R7
2.2k 2.2k
5 UIE

74AHCO5

6
D
8
B
A
Title
THS8200 EVM REV1.1-12C
Sze Number Revison
8 REV 1.1
Dal 27-56p-2005 Shed 201 6
File: XAEVM Design FileSTVP7000_EVM_YIORMIDIBREV LOVTVP7000EVM_RTM\THS8200EVM_MODULE_REV1_2THSB8200EVM_MODULE_REV1,_2.ddb
‘ 6




D
Dsv Dsv Dsv
P2 ]’
L o 2o |‘~*°— x
— sv o SV —o— OND C
GND o GND & GND
GND 25— GND o RCr9 Eo
oL F—o— GND 5 RCi8 Eo BCb8
SCL DA SCL/PHI_ACK X545 — AMXCLK a4 ROI7 Bl BCb7
SDA SDA/PHI_RWW 2683 — ALRCLK 83 ROI6 Bl BCh6
<55— PHI_DSRRD Xy ASCLK g RO'5 Bt BCb5
55— PHI_CS >T AMCLK 81 RCr4 Bt BCh4
E5— PHI_AL 5 — GND 80 RCr3 Bt BCb3
HEEE— PHI_AD H=E— GPIO7 = RCr2 Bt 105 BCh2
>&=— PHI_D7 H==— GPIO6 RCr1 Bt 108 BCbl
>&=— PHI_D6 H==— GPIO5 RCr0 107 BChO
& PHI_D5 H=— GPIO4 GND GY[9.0] 9 06 ] G\D
&=2— PHI_D4 GND -2— D9 5 105 GY9
>&=— PHI_D3 H==— GPIO3 >=>— D8 104 GY8
>&5— PHI_D2 H=—— GPIO2 —— D7 103 GY7
>&S— PHI_D1 H=>— GPIO1 <>— D6 102 GY6
>&=— PHI_DO H=E=— GPIOO >Z=— D5 01 GY5
GND = 20— INTREQ — D4 100 GY4 —
X=5— CLK5M1 >T GPCL e— D3 90 ] GY3
<—— FPDATIVSYA/M2 T—3s — GND e — D2 o8 ] G2
<—=— FFRSTW/CBFLAG X3 — ITRDY Xe— D1 o7 1 GY1
25— FSY/HCIHSYA/~BLNK 36— SoGouT >es— DO %6 ] GY0
>—2— VGAVI/SYNC_T >T VACTIVE ONN RESET GND D o] G\ND
>—— FFIE/CCVALID >T D_SCLK CONN_RESE RESET FID o FID
>é—— FFWE/DVALID >T D_RDY HSYNC >2— PALI VSYNC >T GLCO
4<—5— FFRSTWIN/~SCLK X3 — DPREF <_HSYNC HSYNC VSYNC o ] VSYNC
45— FFRE/DIG_H >T D_HS 25— AVID LK >T PCLK
>é—— FFOE/DIG_V X==— D_VS >E=— PREF SCLK SCLK
SAMTEC_TMMS_120PIN_F_RA
B
A
Title
THS8200 EVM REV 1.1 - CONNECTOR
Sze Number Revison
8 REV 1.1
Dal 27-56p-2005 Shed 301 6
File: XEVM Desgn FileSTVP7000_ EVM_VIOPMIBREV LOTVPT000EVM_RTM\THSS200EVM_MODULE_REV1 2THSS200EVM_MODULE REV1, 2.ddb




D
Cr(
Cr:
Cr:
Cr:
Cr
Cr
Cre
Cr’
Cr
Cr
HEADER 10X2
H2
1 20—
3 4 O—4
5 6 0—4
7 8 0—14
9 10 o—4
1 12 o—4
13 14 0—4
5 15 16 0—4 ¢
9 17 18 o—4
19 20 o—4
HEADER 10X2
HEADER 8X2
BCh[9..0] H3
£t 1 2 o—
BCl 3 4 O—4
BCl 5 60—
BCl 7 8 0—4
BCl 9 10 o—4
BCI 1 12 o—4
BCI 13 14 0—4
BCI 15 16 0—4 |
BCI 17 18 o—4
19 20 o—4
HEADER 10X2
Vs SDA B
Ta Ta
S 3
VS oUT HVS QUL =
= o
HS SCL
Ta Ta
S 3
HS ouT HHSOUT —
= o
D18v A33V
Ta Ta
S 3
_s— _ ¥
D3.3v
Ta
o  IN—|
D3
L
A
Title
THS8200 EVM REV1.1- TESTPOINTS
Size Number Revision
c REV 1.1
Date 27-Sep-2005 Sheet4 of 6
File: X:\EVM Design Files TVP7000 EVM Dgnﬂ]ﬂv O\TVP7000EVM_RTM\THSB8200EVM_MODULE_REV1 2THS8200EVM_MODULE_REV1_2.ddb




1 2 3 4 5 6
Cs 105
0.1uF 0.1uF
=C6 109
0.1uF 0.1uF D
D18V
ca c7 c10 c12
0.1uF 0.1uF 0.1uF 0.1UF
1-2 0x42 - Default
2-3  0x40 —
D3 3V
RO
10k
RIPR
< N BNC_RA
RPR
8200 12cA 2 Q12C
MP3 G YOUT 1 2 GY
3
© R23
75
8
L4 L7 L9 GIY
YYYy BNC_RA
] L ] L L GY
[ Bohp.oashia c31 33 34
DD DD DD D@ CAP 805 EAPaos EAPaos
[@ [« [@ (¢! [e] (e [e) [e) [e] (0] -
SeeeRe T
[ roqe.o Rl
2 BRI E:
ge EekkEEREE J <,J
B PBOUT 1 2 B PB
F2 BIPB
U2 7R524 BNC_RA
NOFTVO-OO o pen B PB
SEEREREEI SRR EREE
FIICCITEFROan0000anD
RCrL GND_IO ) A3 3V
RCI0 VDD_IO D33V
HSYNC i e
B L e s S
~ 0 L10 L1l L12
GND_IO AVSS
f - 2 B PBOUT YYM YY)
o33\ VDD_IO = ABPb 1 1
[FD 3 FID AVDD T &
i 5 om o ferd c20 22 21| c23
10k 0 evr g AVDD 33V 3 v o H
51 3 CompiA® 047fF_JouroJrge] wr CAP_805 P 805 P_805
25— GY6 COMPL COMP 1 S
25— GYs COMP2 =0 R16—42 %
=] 6v4 FSAD. =X R12 2k B
%] 6Y3 FSADJL , RIL 2 T
56 gf |\2’c§; 8200 12CA R17 12 -
57 |
GY0 VDD_DLL {D1 8v J J
[ eveal SI[SVOI —gg DVSS 2 CLRIN SCLKIN - -
DVDD_? GND_DLL
- | R PROUT 1 2 R PR
[CRESET >*™=—"— RS} & TEsT
% % ogo 48 = s P4 HSOUT| &
ago )
29§38858855238388535 3
228822088526838283833 VS OUT.
07 o‘
B3| 3
Crmrisen
VS OUT ~
SDA oA DB15F
SCL A4
SCL 2 DIV
alslslsls slolulz
2|Bl[8[8 2138
R2 O b e e e %%%%g
SR XLk SCLKIN ajojgg)s ol ol fad o}
810,01
¢ D656/9.0] R
e
A
Title
THS8200 EVM REV1.1- MAIN
Sze Number Revison
8 REV 1.1
Dal 27-56p-2005 Shedl5 ol 6
File: XAEVM Design FileSTVP7000_EVM_YIORMDEBREV LOTVP7000EVM_RTM\THS8200EVM_MODULE_REV1_2THS8200EVM_MODULE_REV1, 2.ddb
1 2 3 4 5 ‘ 6




RESET ON POWER UP

D3 3v
Remove R8 to disable
RESET from Connector o
5 100k
[ CONN RESED A o—MAN RESET
| ORESET
OPTIONAL 5V, 3.0A DCINPUT LPB
C25
MAIN SUPPLY FROM CONNECTOR J e
A4
F1 FUSE psy
EioﬂZEH a H5 . o5
3 b ENER
= i S526
HEADER 3
~
THS8200 POWER SUPPLY

VOUT1 1S 3.3V 500mA
VOUT2 1S 1.8V 250mA

POWER ON LED (+5V)

Dsv R19
250k
ua
X—5— NC NC
Gy VINIA VOUTIA
VINIB VOUTIB
MAN RE: h
P c MR
R18 22 0.u /ENL e
330 RESET = ne2
IRESET
GND VOUT2A
t To—] VIN2A VouT28
VINZB NC
C: TPS70251
WLED 22ul 0.1uf

D
8
B
A
Title
THSB8200 EVM REV1.1 - POWER
Sze Number Revison
8 REV 1.1
Dade: 27-56p-2005 Shedl6 ol 6
File: ‘ XAEVM Design FileSTVP7000 EVM i&owﬂvxmwwmosvm RTM\THS8200EVM_MODULE_REV1_2THSB8200EVM_MODULE_REV1, 2.ddb




J@ TEXAS
INSTRUMENTS

SLEUO0G6

Appendix A. Recommended PLL Settings
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IMPORTANT NOTICE

Texas Instruments Incorporated and its subsidiaries (TI) reserve the right to make corrections, modifications,
enhancements, improvements, and other changes to its products and services at any time and to discontinue
any product or service without notice. Customers should obtain the latest relevant information before placing
orders and should verify that such information is current and complete. All products are sold subject to TI's terms
and conditions of sale supplied at the time of order acknowledgment.

Tl warrants performance of its hardware products to the specifications applicable at the time of sale in
accordance with TI's standard warranty. Testing and other quality control techniques are used to the extent Tl
deems necessary to support this warranty. Except where mandated by government requirements, testing of all
parameters of each product is not necessarily performed.

TI assumes no liability for applications assistance or customer product design. Customers are responsible for
their products and applications using TI components. To minimize the risks associated with customer products
and applications, customers should provide adequate design and operating safeguards.

TI does not warrant or represent that any license, either express or implied, is granted under any Tl patent right,
copyright, mask work right, or other Tl intellectual property right relating to any combination, machine, or process
in which TI products or services are used. Information published by Tl regarding third-party products or services
does not constitute a license from Tl to use such products or services or a warranty or endorsement thereof.
Use of such information may require a license from a third party under the patents or other intellectual property
of the third party, or a license from Tl under the patents or other intellectual property of TI.

Reproduction of information in Tl data books or data sheets is permissible only if reproduction is without
alteration and is accompanied by all associated warranties, conditions, limitations, and notices. Reproduction
of this information with alteration is an unfair and deceptive business practice. Tl is not responsible or liable for
such altered documentation.

Resale of Tl products or services with statements different from or beyond the parameters stated by TI for that
product or service voids all express and any implied warranties for the associated TI product or service and
is an unfair and deceptive business practice. Tl is not responsible or liable for any such statements.

Following are URLs where you can obtain information on other Texas Instruments products and application
solutions:

Products Applications

Amplifiers amplifier.ti.com Audio www.ti.com/audio

Data Converters dataconverter.ti.com Automotive www.ti.com/automotive

DSP dsp.ti.com Broadband www.ti.com/broadband

Interface interface.ti.com Digital Control www.ti.com/digitalcontrol

Logic logic.ti.com Military www.ti.com/military

Power Mgmt power.ti.com Optical Networking www.ti.com/opticalnetwork

Microcontrollers microcontroller.ti.com Security www.ti.com/security
Telephony www.ti.com/telephony
Video & Imaging www.ti.com/video
Wireless www.ti.com/wireless

Mailing Address: Texas Instruments
Post Office Box 655303 Dallas, Texas 75265
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